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Advanced and Customized Net Conference   
With Cisco WebEx Meeting Center   
Meeting Tips 
 
Meeting Tips for WebEx Meeting Center provides tips and techniques that you can use to conduct more efficient meetings 
on the Web. This guide assumes that you are already familiar with the basics of WebEx Meeting Center, and thus it does 
not provide detailed instructions for using WebEx Meeting Center.  
 
To obtain detailed instructions for using the options and features that this guide describes, refer to the online Help on your 
Meeting Center Web site.  
 
Setting up a meeting  
For meeting hosts  
This section provides tips and techniques that can help you to set up a scheduled or instant meeting effectively.  
 
Choosing a scheduler 
To schedule a meeting, you can choose either of the following schedulers:  

 Advanced Scheduler: Lets you set all options for your meeting. These options including basic meeting 
information, recurrence, teleconferencing, the attendee list, registration, agenda, attendee privileges, security 
options, and other meeting details.  

 Quick Scheduler: Lets you set a smaller number of options for your meeting. These options include basic 
meeting information, teleconferencing, and the attendee list.  

 
Securing your meeting  
You can provide security for your meeting by doing any of the following in the Advanced Scheduler:  

 Require a password: If you specify a password for the meeting, attendees must provide this password to join the 
meeting.  

 Schedule an unlisted meeting: An unlisted meeting does not appear on the meeting calendar on your WebEx 
Meeting Center Web site. To join an unlisted meeting, attendees must click the Unlisted link under Attend a 
Meeting on the navigation bar, then provide a unique meeting number. 

 Exclude the meeting password from email invitations: If you have specified a meeting password, you can prevent 
the password from appearing in the email invitations that your WebEx Meeting Center Web site automatically 
sends to attendees.  

 Require attendees to log in: You can require that attendees have a user account on your WebEx Meeting Center 
Web site. Thus, attendees must log in to your site before they can attend a meeting.  

 Require attendees to register for the meeting: You can require each attendee to fill out a registration request that 
includes his or her name, email address, and other information that you require, and then send the request to you. 
You can then accept or reject each registration request. The level of security that you choose depends on the 
meeting's purpose. For example, if you schedule a meeting to discuss your company picnic, you might specify 
only a simple password for the meeting. On the other hand, if you schedule a meeting in which you will discuss 
sensitive financial information, you may want to specify that the meeting is unlisted and require attendees to log in 
to your site to attend. 

 
 
Scheduling a recurring meeting  
If you want to host a meeting on a regular basis, you can specify one of the following recurrence patterns when scheduling 
a meeting using the Advanced Scheduler:  

 Daily recurrence  
 Weekly recurrence  
 Monthly recurrence  
 Yearly recurrence  

 
To set up a recurring meeting, specify recurrence options on the Date & Time page in the Advanced Scheduler.  
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Including a teleconference 
 
When scheduling a meeting, you can select one of the following teleconferencing options in either the Quick Scheduler or 
Advanced Scheduler. To access these options in the Advanced Scheduler, click Teleconference on the right; in the Quick 
Scheduler, click Change audio option.  

 None: Select this option if you do not need to set up a formal teleconference or use a teleconferencing service—
for example, if you want to meet with only one other attendee.  
 If you schedule a meeting without using a teleconferencing service, it is recommended that you clearly 

specify in your email invitation how you plan to provide audio for the meeting; otherwise, attendees may not 
realize that your meeting includes audio. For example, you can inform attendees that you will call them once 
the meeting starts. To specify this information, you can create a custom email invitation. For details, see the 
Creating a custom email invitation for attendees section. 

 Verizon teleconferencing service: The meeting includes an integrated teleconference. If you select this 
option, select one of the following types of teleconferences:  

 Attendees call in: Select this option to have attendees call a phone number to join a teleconference.  
 Attendees receive a call back: Select this option to have the teleconferencing service call attendees to 

connect them to the teleconference. 
o In a call-back teleconference, only meeting attendees who have direct phone lines can receive a call 

back from the teleconferencing service. If a receptionist answers the call from the service, or the 
attendee's phone system uses a recorded greeting for incoming calls, the attendee cannot receive a call 
back. However, an optional call-in phone number for the teleconference is always available in the 
Meeting window.  

 

     
 
Telephony: Identify Active Speaker 
 
The active speaker icon reacts to sounds during a live call, informing leader’s who is currently speaking even allowing them to 
mute callers who may have background noises that could be interrupting the flow of the call.  This feature also lets leaders 
identify the party speaking, allowing them to address parties by name, even help take more detailed notes.  
 

 
 

 
Granting privileges to attendees  
 
When scheduling a meeting using the Advanced Scheduler, you can grant privileges to or remove them from attendees, 
using the options on the Attendee Privileges page. The privileges that you select determine whether all attendees can 
share documents, view shared documents independently, annotate shared documents, and so on.  
 
For most meetings, it is recommended that you accept the default privileges, and then grant additional privileges as needed 
to all attendees or individual attendees during the meeting. That way, you can maintain control over the meeting. For 
example, if you are giving a presentation and want to ensure that attendees follow along with your slides, you probably do 
not want to grant them the View any page privilege, which lets them navigate your presentation independently.  
 
 
 
 

 610-555-1111 
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Letting attendees join a meeting before its scheduled starting time  
 
If you use the Advanced Scheduler, you can let attendees join a meeting before you actually start it. For example, you can 
specify that attendees can join a meeting up to 10 minutes before its scheduled starting time. This option, which is available 
on the Date & Time page in the Advanced Scheduler, helps to prevent attendees from having to wait for you to start the 
meeting before they can join it. 
 
If you do let attendees join a meeting early, you can automatically share a presentation or document once an attendee joins 
the meeting. For details, see the Sharing a presentation automatically section.  
 
 
Sharing a presentation automatically  
 
If you let attendees join a meeting before its scheduled starting time using the Advanced Scheduler, you can share a 
presentation or document automatically. The presentation or document can inform or entertain attendees while they are 
waiting for you to start the meeting. To share a presentation or document automatically, you must select it when scheduling 
a meeting. The presentation or document must be in the WebEx Universal Communications Format (UCF). To save any 
document or presentation as UCF, use the WebEx Universal Communications Toolkit or the WebEx Document Manager, 
which are available on the Support page on your WebEx Meeting Center Web site.  
 
 
Using meeting templates  
 
To save time when scheduling a meeting, you can set up a meeting template. A meeting template automatically sets all the 
options your meeting, except the password and date and time options. To set up a meeting template, use the Advanced 
Scheduler or Quick Scheduler to set the options you want to use for your meetings, and then click Save As Template at 
the bottom of the scheduling page. The next time you want to schedule a meeting, simply choose the template from the Set 
options using template drop-down list at the top of the Advanced Scheduler or Quick Scheduler page. Before you 
schedule the meeting, you can change any of the options that the template applied to your meeting.  
 
 
Creating a custom email invitation for attendees  
 
If you invite attendees to a meeting when scheduling it, WebEx Meeting Center automatically sends invitation email 
messages to the attendees. However, you can modify the automatic email message, as follows: Initially invite only yourself 
to the meeting. Once you receive the invitation email message, you can modify it as needed, and then forward it to 
attendees. In your custom invitation email message, ensure that you include all necessary meeting information that the 
original message contained, such as the date and time for the meeting, the meeting agenda, the URL for joining the 
meeting, and voice conferencing information.  
 
N o t e: Do not modify the meeting confirmation email message that you receive. This message contains information and 
URLs that you need to host the meeting.  
 
 
Updating information about a scheduled meeting  
 
You can update any information about a meeting, including its starting time, recurrence pattern, or list of invited attendees. 
Once you modify a meeting, you can choose to send attendees a new invitation email message that informs them that you 
have modified information about the meeting. Attendees whom you removed from the attendee list receive an email 
message informing them that you have retracted their invitations.  
 
 
Letting another user schedule a meeting on your behalf 
  
You can grant permission to one or more meeting service users to schedule meetings on your behalf. Once another user 
schedules a meeting for you, the meeting appears in your list of meetings on the My WebEx Meetings page. You can then 
start the meeting and host it as you normally can when you schedule meetings yourself. 
 
To let another user schedule a meeting for you, specify that user in your user profile on your WebEx Meeting Center Web 
site. You can select only a user who has an account on your WebEx Meeting Center Web site.  
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Using Microsoft® Outlook® to schedule a meeting  
 
If you use Microsoft Outlook 2000 or later, and your WebEx Meeting Center configuration includes the WebEx Integration to 
Outlook option, you can schedule, start, and join online meetings using Microsoft Outlook. For instructions on using 
Integration to Outlook, refer to the guide WebEx Integration to Outlook User's Guide. This guide is available on the Support 
page on your Meeting Center Web site.  
 
 
Using One-Click Meetings  
 
If you often meet with others to spontaneously collaborate on documents, spreadsheets, and so on, you can set up One-
Click Meeting shortcuts for your Microsoft Office applications. Then, while working in a Microsoft Office application, you can 
instantly start a meeting and share the document that is open in that application. Similarly, you can set up a One-Click 
Meeting shortcut for your Microsoft Windows®  shortcut menu. This shortcut lets you right-click any document or 
application on your computer to instantly start a meeting and share that application or document in the meeting. To set up 
One-Click Meeting shortcuts, do either of the following on your WebEx Meeting Center Web site  
 

 Click My WebEx > My Meetings > One-Click Setup  
 On the navigation bar, click Host a Meeting > One-Click Meeting.  

 
 
Starting and conducting a meeting  
For meeting hosts  
This section provides tips and techniques for starting and conducting a meeting.  
 
Starting a scheduled meeting  
  
Meetings do not start automatically at their scheduled times. As the meeting host, you must first start a meeting before 
attendees can join it. Thus, it is recommended that you start a meeting about 10 minutes before its scheduled starting time, 
to accommodate any attendees who want to join a few minutes early. Alternatively, you can let attendees join a meeting 
before you actually start it. In this case, the meeting automatically becomes “open” at a time that you specify when 
scheduling it. For more information, see Letting attendees join a meeting before its scheduled starting time section.  
 
 
Helping attendees to join a meeting  
 
If attendees have trouble joining a meeting, they may be attempting to join a meeting that you have not yet started. On the 
meeting calendar on your WebEx Meeting Center Web site, under Status, the text Join Now and a green indicator appear 
only after you start the meeting. Otherwise, the text Not started appears. 
 
Because a meeting’s status can change at any time, an attendee can periodically click the Refresh button on the page to 
determine whether you have started the meeting. You can help to avoid the need for attendees to refresh the meeting 
calendar by letting them join the meeting before you actually start it. For details, see Letting attendees join a meeting 
before its scheduled starting time.  
 
 
Preventing unauthorized access to a meeting in progress  
 
Once all required or invited attendees have joined a meeting, you can “lock” the meeting by restricting access to it. 
Restricting access to a meeting helps prevent anyone else from joining it. To lock a meeting, choose Restrict Access on 
the Meeting menu.  
 
 
Helping attendees to join a teleconference 
  
If your meeting includes call-in or call-back teleconference, instructions for joining the teleconference automatically appear 
in a message box on an attendee’s screen once that attendee joins the meeting. Attendees can also obtain instructions for 
joining a teleconference at any time during the meeting, by choosing Join Teleconference on the Participant menu. If 
your meeting includes an integrated call-in teleconference, the call-in number also appears on the Info tab in the content 
viewer.  
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Presenting information 
  
For presenters  
This section provides tips and techniques for sharing presentations and applications, polling attendees, and recording 
meetings.  
Preparing for your meeting  
 
These tips can help you to avoid problems and ensure that your meeting runs smoothly:  

 Before you start a meeting, ensure that your computer and network are working properly to avoid any unexpected 
problems during the meeting.  

 Place all the files that you intend to share in a single folder, so you can quickly locate them during the meeting  
 Start your meeting early, and practice sharing the documents and applications that you intend to share with 

attendees. That way, you can troubleshoot any problems before attendees join the meeting.  
 Ensure that you have the URL for your backup meeting site handy, in case your primary site is unavailable. If you 

do not know the URL for your backup site, ask your WebEx Meeting Center site administrator. 
 Once you start a meeting, write down the meeting number, host key, and, if you are using the integrated 

teleconferencing service, the teleconference number. These numbers appear on the Info tab in the content viewer  
 
 
The Leader Console 
 
The console is an easy interface that uses the familiar Microsoft Windows® menus to make participating in a meeting 
very intuitive.  You have tools available to you in the console to allow you to communicate with the leader or other 
participants.  

 

 
 
 
Floating Icon Tray 
 
The Floating Icon Tray appears when sharing an Application.   It may be moved anywhere on the console.  The tray includes: 
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Join Teleconference 
 
Leaders and Participants may join the audio portion of the meeting multiple ways. They may: 

 Call into the Instant Meeting audio bridge.   
 Enter their phone number to receive a call back.  
 Participate in the audio call via Internet Audio. 

 
 Call into the Instant Meeting audio conference - When participants enter the meeting console the dial-in numbers 

will display on the Info tab and in the Meeting Information section.  In addition to toll and toll free, global numbers 
are available as well.  Dial In User Merge is also supported as a dial in option which merges the user’s audio and 
net identities within the participant panel.  Please refer to the Dial In User Merge User Guide for more.  
 

 
 
 Dial Back: Leaders and participants may enter their number to receive a call from the conference service.  This 

synchronizes the audio and net sessions so that each user is identified by name in the participants panel.  This also 
enables the active speaker functionality.  (see Telephone: Identify Active Speaker section.)  
 

  
 

 Internet Audio: Leaders and participants may select Call Using Computer to join the Instant Meeting audio conference 
call from their Microsoft® Windows® based device via their headset, speakers, and microphone.  
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• Each participant who joins via Internet Audio will see the headphone icon appear next to their name in the 

participant panel.  
 

 
 
 

• If a user is disconnected, try again by selecting “Call Using Computer” or join the audio conference via the 
“Use Phone” option 

 

 
 
• Audio control features are available from the Audio Conference panel via the keypad icon. (mute, unmute, 

etc.) 
• Internet Audio user can use the keypad for all DTMF functions available with their Instant Meeting with the 

exception of DIAL OUT. 
• Click the keypad icon to display the keypad and enter the DTMF command. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

See next section for instructions on how to setup Internet Audio.
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Internet Audio Setup 
 
Audio Conferencing Integration with WebEx will allow PSTN and any VoIP audio conference including Internet based audio 
users to join the same Instant Meeting Audio Conference call during a WebEx Meeting Center  session.  Each user will 
have several audio options to join the meeting: 
   
 Call me back on the telephone number provided by the user.  
 Call Using Computer (streams the audio to a desk top.) 
 Dial into the call using your device keypad. 
 
System Requirements for Internet Audio 
 

 Windows XP, Windows 7 
 Microsoft Internet Explorer, Mozilla Firefox 
 Netframework 4.0 for Windows (May be downloaded during the Audio Client Installation below.) 
 Headset that supports two way audio 
 Device that has both audio speakers and microphone 
 Shared Dynamic Audio Conference bride platform required 
 Hybrid Audio enabled on the WebEx site 

 
Installation of Internet Audio Client 
 

 If you don’t have the Internet Audio client installed you will prompted to install the client, just click Install Now. 
 

 
 

 User must read the Terms and Conditions and agree by selecting the checkbox.  After acceptance, the  Install 
Now option will appear, 

 
 
 When Install Now is selected from the Firefox browser, the user will be prompted to save the 

AudioClientsetup.msi file. Click Save File.  
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 When Install Now is selected from the Internet Explorer browser, the user will be prompted to run or save the 
AudioClientsetup.msi file. 

 

 Go to the saved file, locate the AudioClientSetup.msi file and double click to install. 
 

 
 

 
 The next step shows the Audio Client being installed. 

 

 
 

 
 When completed, the user will be prompted that the Audio Client has been successfully installed. 
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 The Audio Conference screen will automatically change the option from Install Now to Call Using Computer. 

 

 
 
 

 Click Call Using Computer.  When running for the first time, the user will have an option to test their speakers and 
microphone. Click okay when done. 
 

 
 
 

 User will be connected to conference. 
 

 
 
 

 When the user is connected, the user will have several options: 
 Adjust/test volume 
 Adjust/test Microphone 
 Leave Audio Conference 
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 The user is also seen in the participant section with a corresponding headset to identify they joined via Internet 
Audio. 
 

 
 
 
 The Audio Client application will show up in the user’s list of applications installed in their computer. 

 

 
 

 

Press 1 to Join Audio: 
 

 If the Site Administrator has the Press *1 feature turned on for your site, participants will be asked to enter a *1 to 
join the audio portion of the conference if they are joining the audio by having the audio bridge dial out to them. 
This will prevent voicemail boxes from being added into the audio conference by mistake.   

 The pop up window for the Join Teleconference will indicate press 1 however the audio command will tell 
participant to Press *1.   

 Please follow the audio instruction to Press *1 and disregard the Press 1 instruction in the pop up window within 
the WebEx console.   

 A future release of WebEx will allow the text within the Join Teleconference window to be customized.   
 
Note: The Host/Leader will not be prompted to press *1.  If the Leader has selected the option to allow the first participant 
to become the presenter, they will also not be required to Press *1 to enter the audio portion of the call. 
 
Site Admin setting: 
When the Site Administrator selects Off for the Press 1 feature, participants must enter *1 to join the audio portion of the 
call when the audio bridge dials out to them. 
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Press 1 User Experience: 

When the Press 1 feature is enabled, participants will be prompted via the audio bridge to Press *1 to enter the audio 
portion of the call when using the dial back feature. 
 
Join Teleconference window: 

              
 
Once you are connected to the teleconference the Teleconference icon will be updated to reflect Connected. 
 

 
 

 

Telephony: Identify Active Speaker 

 

 The active speaker icon reacts to sounds during a live call, informing leaders who are currently speaking, even 
allowing them to mute callers who may have background noises that could be interrupting the flow of the call.  This 
feature also lets leaders identify the party speaking, allowing them to address parties by name.  
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Sending and Receiving Video 
 
If a video camera is installed on your computer, you can send video. Other participants can see you, or whatever you focus 
your webcam on. To see video, participants do not need to have a webcam installed on their computers.  
 
WebEx Meeting Center and Training Center support high-definition (HD) video with up to 720p resolution. Other WebEx 
services, such as Event Center and Support Center, support high-quality video with up to 360p resolution. The Cisco 
technology automatically adjusts video to the highest quality for each participant according to the computer capabilities and 
network bandwidth.  
 
Your administrator can set video options at the site level. A meeting host can set video options on the scheduler as well as 
in the meeting. If your site or meeting is not set up to use HD or high-quality video, standard video is used.  
 

 
 
If you have a High Definition camera and you select the video icon, a one-time notification indicating You are ready to 
send HD video to other participants displays. 
 

                
 

After you start sending video, you can perform the following tasks depending on your role. 

Role  Tasks  
Host  What you can do:  

Start or stop sending video at will.  
Lock focus on one participant.   
View everyone who is sending video on one big screen.  
List participants or show thumbnails.   
Set webcam options.  

Participant  What you can do:  
Start or stop sending video at will.  
View everyone who is sending video on one big screen.  
List participants or show thumbnails.  
Set webcam options  

 
Minimum system requirements  
To send or receive video with a resolution of 360p, ensure that your system meets the following minimum requirements:  
 
Action  What you need 
Send   A webcam capable of producing high-quality video. WebEx supports 

most webcams of this type  
 A computer with at least 1 GB of RAM and a dual-core processor  
 A fast network connection  

Receive   A computer with at least 1 GB of RAM and a dual-core processor 
 A fast network connection  

 
 
 
 
 
 

To start or stop sending video, select the 
video icon beside your name. The icon turns 
green when you are sending video.
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Desktop Video Options 
 

 Multipoint video is the default setting and up to 6 video windows may be displayed at one time. 
 The Presenter can lock the video and participants may pause their own video. 
 Each participant may select their Session Options and Personal Options to adjust their bandwidth settings and 

resolution. 
 Each webcam is different and you should follow the manufacturer’s instruction for use however, in general, 

make sure it is plugged in and turned on before the net conference session begins.   
 
 
Setting the video for the main display: 
 
Select the name tag on the main display. 
 

 
 
 
In the Lock Focus on a Participant dialog box, select one of the following: 
 
 The active speaker. This is the default. The display focuses on the current speaker and changes as the speaker 

changes. 
 A specific participant. The display focuses on only the specific participant that you select. 

 

 
 
Setting webcam options: 
Usually, you can set options for general settings, such as contrast, sharpness, and brightness, but options can vary 
depending on your web camera. 
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Video Full Screen Mode (Active Talker) 
 

 Click the Full Screen Icon  
 The active speaker (or a specific participant) is shown in the main display with all other participant videos arranged in a 

row beneath. 
 To return to the view where you see everyone who is sending video, select this icon in the upper-right corner of your 

screen.  

 
 
Chat  
    
During a meeting, the presenter can specify chat privileges for participants. These privileges determine to whom 
participants can send chat messages.   If chat has been enabled you will be able to chat with the leader or other 
participants during the call. 

 
 

 To send a chat message: 
o Open the Chat panel. 
o In the Send to drop-down list, select the recipient of the message. 
o Enter your message in the chat text box. 
o Click Send. 

 
 
 
 

 
Microsoft PowerPoint® Notes Panel 
 

 Speakers may view their notes discretely from the console when they Share a Presentation  
 Available from the Panels drop down menu 

 

        
 
 
Using an assistant presenter  
 
If you want to focus on speaking during a meeting, or want to view your presentation from an attendee's perspective, you 
can assign the presenter role to another attendee. This attendee can “drive” the presentation, by advancing slides and 
sharing applications as you need them.  
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Using annotation tools  
 
When sharing a presentation or application, use the annotation tools to highlight text or graphics, emphasize points, and 
draw and write notes. If you are conducting a meeting with few attendees, you might want to allow attendees to annotate 
your shared presentation or application.  
 
Attendees can use annotation tools, for example, to point to areas on a slide about which they want to comment or ask a 
question. When you share a presentation, annotation tools appear above the content viewer: To access annotation tools 
while sharing an application, click the Start Annotation button in the Floating Icon Tray. 
 

 
 
The Tools panel appears:  
 

 
 
 
Choosing an option for sharing presentations or documents 
  
WebEx Meeting Center provides the following options for sharing a presentation or document:  

 Sharing a presentation or document in the content viewer: The Presentation or Document command on the 
Share menu displays a presentation or document in the content viewer. If you used Microsoft PowerPoint to 
create your slides, the content viewer also displays any animations and transitions on the slides. This sharing 
option provides a set of annotation tools that both you and attendees with annotation privileges can use; viewing 
options, such as thumbnails and full-screen view; and simultaneous use of the entire Meeting window, including 
the participant list and chat.  

 
 Sharing a presentation as an application: Instead of displaying a presentation or document in the content 

viewer, you can open the presentation or document in the application with which it was created, and then share 
the application. Sharing a presentation or document as an “application” lets you or an attendee edit the slides or 
pages during the meeting.   

 Sharing a presentation or document by sharing your desktop: Sharing your desktop provides the same 
benefits as sharing your presentation as an application. However, desktop sharing lets you show any part of your 
desktop to attendees and quickly share additional applications.  
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Choosing an option for sharing Web pages 
  
During a meeting, you can display Web pages to attendees in one of three ways: 

 Web browser sharing: Web browser sharing allows you to take attendees on a “Web tour.” Attendees can view 
each Web page that you access, either on the Internet or on your organization’s private intranet. You can 
optionally allow attendees to control your Web browser. This option uses more bandwidth than the following two 
options.  

 Web content sharing: To share a Web page on the Internet that includes multimedia effects, such as sound and 
animation, you can use Web content sharing. This option lets you specify a URL for a Web page, video, audio file, 
flash file, or WebEx Recording, and display the content in the content viewer on each attendee’s screen. 
Attendees can hear sounds and interact with other multimedia effects independently in their content viewers. This 
option also lets you share a single Web page more quickly than you can using the Web browser sharing option; 
however, it does not allow you to guide attendees to other Web pages.  

 Presentation sharing: Using the WebEx Universal Communications Toolkit, you can insert a link to a Web page 
directly in a Microsoft PowerPoint presentation. When you share the presentation in the content viewer during a 
meeting, using the Presentation or Document command on the Share menu, the Web page automatically appears 
on the slide on which you inserted its link. This option is useful if you want to include a Web page in your 
presentation but do not want to stop your presentation to use either Web browser sharing or Web content sharing. 
For more information about creating and sharing presentations in which you insert media objects, see Using UCF 
multimedia to enhance your presentation on page 10. 

 
 
Providing handouts to attendees  
 
You can let attendees print handouts at any time during a meeting, as follows:  

 Share the handout by choosing Presentation or Document on the Share menu, and then selecting the handout 
document. The handout appears in the content viewer.  

 On the Participant menu, choose Privileges.  
 In the Attendee Privileges dialog box, select the Print check box, and then click Assign. Attendees can now 

print the shared handout by pointing to Print on the File menu, and then choosing Document.  
 
 
Synchronizing displays 
  
When you share a document or presentation in the content viewer, some attendees may not be able to view the entire page 
or slide that you are sharing, because their viewers are set to different magnifications. To resolve this problem, simply click 
the Sync Displays for All button on the toolbar at the bottom left corner of the Meeting window. All attendees’ content 
viewers then display the page or slide at the same magnification that you set in your viewer.  
 
 
Improving the performance of document or presentation sharing 
  
You can improve the speed at which shared pages or slides appear to attendees using these techniques:  

 Limiting the number of animations and slide transitions that you add to Microsoft PowerPoint slides.  
 Minimizing the number of screen captures that you add to slides, especially if they are bitmap graphics. Such 

graphics do not compress well.  
 Not including more than 20 to 30 slides in one presentation file. If you want to share more slides, create a 

separate presentation file for each set of 20 to 30 slides.  
 Keep the size of the presentation file to a maximum of 5 MB.  

 
 
Displaying Slide Animations and Transitions 
  
When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can display animations on the slides 
and slide transitions. After you begin sharing a presentation, you can perform slide transitions or animations:  

 Click anywhere in the content viewer to set the input focus. A blue border around the shared slide indicates that 
the viewer has input focus.  

 Do either of the following:  
 To perform the next slide transition or animation, click the Next Page button on the toolbar  
 To perform the previous slide transition or animation, click the Previous Page button on the toolbar.  

 
N o t e: If you are unable to display animations or slide transitions, ensure that you import the presentation using the 
WebEx Universal Communications Format (UCF) import mode: On the Meeting menu, choose Options, and then click the 
Import Mode tab. 
10 of 15 Successful Web Meetings  
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Using UCF multimedia to enhance your presentation 
  
You can make an online meeting more engaging by sharing these types of media files in the content viewer:  

 WebEx Recording Format (WRF) files  
 Video files  
 Audio files  
 Flash movie and interactive Flash files  
 Web pages To share a media file, you must use a Universal Communications Format (UCF) media object. A 

media object links to the media file and provides a window in which the file appears. An object also contains 
options and controls for displaying or manipulating the file.  

 
You can share media files in either of two ways:  
 In a Microsoft PowerPoint presentation: Using the WebEx Universal Communications Toolkit, a plug-in for 

Microsoft PowerPoint, you can insert UCF objects into your slides. You can then share the presentation during a 
meeting. You can download the Universal Communications Toolkit from the Support page on your WebEx 
Meeting Center Web site.  

 As a standalone file: You can share a media file directly in the content viewer. WebEx Meeting Manager creates 
a UCF object for the file automatically, which appears in the content viewer.  

 
N o t e: For more information about creating UCF multimedia presentations, refer to the guide Getting Started with 
WebEx Universal Communications Toolkit. For more information about sharing either a UCF multimedia presentation or 
a standalone media file, refer to the online Help on your WebEx Meeting Center Web site.  
 
 
Sharing graphics quickly 
  
You can quickly share a graphics file with attendees by copying it to your computer's clipboard, and then pasting it in the 
content viewer. To copy an image, do one of the following:  

 Right-click an image on a Web page or in a document, and then choose Copy.  
 Capture the active window on your desktop to an image by pressing the PrtScn (Print Screen) key.  
 Capture your entire desktop to an image by pressing the PrtScn (Print Screen) key.  

 
After you copy an image to your computer's clipboard, on the Edit menu in the Meeting window, choose Paste as New 
Page.  
 
You can paste any bitmap image in the content viewer, such as a GIF, JPEG, BMP, or TIF image. However, you cannot 
paste other types of images—such as EPS or Adobe Photoshop (PSD) images—in the content viewer.  
 
 
Improving attendees' shared views 
  
These tips can help you to avoid common problems with application, desktop, or Web browser sharing: 

 Differences in screen resolution settings between your computer and an attendee's computer may prevent 
that attendee from viewing the entire application, desktop, or Web browser that you are sharing. To help 
avoid this problem, you can do any of the following:  
 Ask attendees to reduce the image of the shared software, by clicking the Sharing button in the upper-

right corner of the sharing window, pointing to View, and then selecting an option.  
 Ask all attendees to set their monitors to the same screen resolution as your screen.  
 �Set your monitor to a lower screen resolution, such as 800 by 600 pixels. 

o For instructions on setting screen resolution, refer to Windows online help.  
 You can also resolve some problems with screen resolution by choosing the View > Show Full-Screen View for 

Attendees command on the Sharing menu, which appears in the title bar of the application or Web browser that 
you are sharing.  

 To improve the quality of attendees' views of a shared application, ensure that your screen display and attendees' 
screen displays are set to the same color depth—for example, 16-bit color.  

 
 
 
Running applications before a meeting starts 
  
To save time during a meeting, begin to run any applications that you intend to share before the meeting's starting time, 
and then minimize their windows. At the appropriate time during the meeting, you can quickly begin sharing an application, 
without waiting for the application to start. 
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Improving the performance of software sharing 
  
To improve the performance of software sharing, do the following:  

 Close all applications that you do not need to use or share on your computer. Closing applications conserves 
processor usage and memory on your computer, thus helping to ensure that WebEx Meeting Manager can send 
images of shared software quickly during a meeting.  

 To ensure that the maximum amount of bandwidth is available for software sharing, close any applications on 
your computer that use bandwidth, such as instant messaging or chat programs, and programs that receive 
streaming audio or video from the Web.  

 Ensure that the WebEx Meeting Manager display mode is set optimally for the application that you are sharing. 
You can choose one of two display modes: one for normal applications and another for graphics-intensive 
applications. To set the display mode, on the Meeting menu, choose Options.  

 
 
Avoiding blocked views  
 
If you cover a shared application or Web browser with another window on your computer's desktop, attendees cannot view 
the area of the application or browser that the other window covers. Instead, a crosshatched pattern appears in the covered 
area on attendees' screens. To help avoid this problem, ensure that you minimize all applications that are running on your 
computer, and then restore the window for only the application or browser that you want to share. To ensure that you do 
not block a shared view and create the crosshatched pattern, use a second computer to join the meeting as an attendee 
and monitor the attendees' view of your presentation.  
 
 
Transferring files to attendees  
 
During a meeting, you can transfer any types of files to attendees, by choosing Transfer on the File menu. The following 
are some examples for using this option:  

 Provide attendees with a copy of your presentation or any other documents that you share during the meeting.  
 If you are training attendees on how to install and use an application, provide attendees with the application's 

installation program. Then, use desktop sharing to show attendees how to install the software.  
 f you take a poll during a meeting, provide attendees with a copy of the poll results file that you saved. Attendees 

can open a poll results file using any text editor. 
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Recording, playing, and editing meetings  
 
This section describes the various options for using WebEx recording to create a video recording of all screen activity on 
your computer, including all interactions, sharing, and audio. In addition, it provides information on editing and streaming 
your recordings.  

 
Recording meetings  
If you want to record a meeting—for example, for a remote team in another time zone—you can record the meeting using 
Recording. You can then publish the recording on your organization’s Web site or intranet. Members of the remote team 
can use WebEx Player to replay the meeting at any time. Recording is available in these versions:  
 

 Network-based meeting recorder The network-based meeting recorder is available during an online meeting. 
This recorder captures screen activity and audio on a WebEx recording server, thereby saving processor 
resources and hard disk space on your computer. The server automatically processes your recorded data, and 
then sends the recording file to your personal folder on your WebEx Meeting Center Web site. Use the network-
based recorder to easily capture all audio in your meeting’s teleconference, without having to use a phone 
recording adapter (a device that connects your phone to your computer’s sound card). However, if you want to 
capture audio in an Integrated VoIP conference, use the integrated meeting recorder instead.  

 
 Integrated meeting recorder. The integrated meeting recorder is available during an online meeting. This 

recorder captures screen activity and audio in a meeting, and then saves the recorded data in a recording file on 
your computer. Use the integrated recorder to capture all audio that plays “through” your computer, such as 
sound that media files play. You can also capture audio in a traditional teleconference using a phone recording 
adapter, which connects your phone to your computer.  

 
 Standalone recorder. The standalone recorder is available only offline—that is, outside of an online meeting. 

This recorder lets you record all screen activity in any application on your computer, and then saves it in a 
recording file on your computer. Use the standalone recorder to create software demonstrations, tutorials, sales 
presentations, and so on. To capture audio in an application recording, simply connect a microphone to your 
computer. You can download the standalone recorder from your WebEx Meeting Center Web site. For detailed 
instructions on using WebEx Recorder and Player, refer to the WebEx Recorder and Player User’s Guide.  

 

Recording to the Server 
 
To begin recording click the REC button from within the console. 

 
 
The Recorder will open.  Click the button to record on the server.  
 

 
 
The following message will appear: 
 

 
 
Click the pause or stop button. 
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View Recording 
 

 To view your recording go to the My Recorded Meetings on the WebEx Meeting Center homepage. 
 Click the recording listed under Topic to display the Recording Information.   
 This will display two links – one for streaming the recording and one for downloading the recording. 

 

 
 

 
Editing your recordings  
 
Before you distribute or publish a recording that you made using WebEx Recorder, you can edit it to remove mistakes, long 
pauses, unwanted segments, and so on. You can edit any WebEx Recording Format (WRF) file that was made using the 
WebEx Recorder. To edit a recording, you must use WebEx Recording Editor, which is available on the Recording and 
Playback page on your WebEx Meeting Center Web site.  
 
 
Streaming recordings on your company’s Web site  
 
On your company’s Web site, you can publish recordings that users have created using WebEx Recorder. Then, anyone 
who visits your Web site can play the recordings by streaming them over the Internet. Streaming allows people to play the 
recordings without downloading them to their computers. 
 
To stream recordings, you can use Create a URL for Recording page on your WebEx Meeting Center Web site. For more 
information, refer to the Recording and Playback FAQ on your site. This FAQ includes a link to the guide Streaming 
Recordings on Your Web Site.  

 You may share your recording with others via email by clicking Send Email. 
 

     
 

 In the Send to area add the email addresses of your recipients. 
 You may also add a personal message to the email 
 You may select to receive a copy of the email. 
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 The recipients will receive an email inviting them to view the recording. 
 

 
 
 

 The Replay will display who attended the call well as the Table of Contents.   
 You may use the Table of Contents to help navigate through the recording 
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Hosting a large meeting 
 
For meeting hosts  
This section provides tips and techniques that can help you to efficiently host a meeting with a large number of participants.  
 
Muting audio  
If you are using the integrated WebEx teleconferencing service, you can prevent distracting noises during a meeting by 
muting the audio for all participants in a teleconference. To do so, on the Participant menu in the Meeting window, choose 
Mute All.  
 
You may also use the Instant Meeting touchtone commands on your phone to control the audio portion of the call.  
 

Instant Meeting Service Touchtone Features 

*0 Operator Assistance. Leaders or participants can press *0 to contact an operator if they are experiencing technical 
difficulties during a conference. 

*1 Help Menu. A pre-recorded message is played privately, listing the touchtone features available to the leader or 
participant. 

*2 Roll Call (in-conference). The leader may initiate the announcement of the names of all individuals who have joined the 
conference. All participants will hear the playback. 

#2 Sub-conferencing. The leader may activate sub-conferencing, allowing participants to confer in mini-conferences within 
the original conference. 

*3 Private Roll Call. The leader or participant may initiate the announcement of the names of all individuals who have joined 
the conference. The playback will be heard only by the leader or participant who has pressed *3. 

*4 Mute All. The leader may mute/unmute the conference participants en masse. The leader line always remains unmuted. 

*5 Conference Continuation. The leader may specify whether or not the active conference will continue once they hang up. 
The default setting is for the call to continue once the leader disconnects. To ensure the call ends when you leave, press *5 
to activate this feature, then hang up. 

*6 Self Mute/Unmute. The leader and/or participants may mute/unmute their own line. 

*7 Lock/Unlock. The leader may “lock” the conference to prevent any additional participants from joining. 

*9 Guest entry. The leader can specify how the entry and exit of participants are announced into the active conference: 
tone, recorded name, or silent. The default setting is “tone.” 

 
 
Using two computers  
 
To ensure that attendees can view shared presentations or applications properly, you (or the presenter) can monitor their 
view of the meeting by using two computers. Use one computer to present information, and use the other computer to view 
the meeting as an attendee.  
 
 
Providing technical support  
 
Provide attendees with a phone number that they can call to receive support from your technical support personnel.  To 
avoid having attendees interrupt a meeting when they need help, provide your support number on the first slide in the 
content viewer, in the header of each slide, or in the agenda.  
 
Establishing meeting guidelines  
 
To help keep a large meeting running smoothly, you can provide attendees with a list of meeting guidelines to follow. For 
example, you can specify how and when attendees can ask questions, request annotation control, request remote control, 
and so on. To provide your guidelines to attendees, choose either option:  

 When scheduling a meeting, specify your guidelines in the agenda.  
 Include your guidelines on the first slide in your presentation. Once attendees join a meeting, they can read the 

guidelines before the presentation starts. 
 
 
Designating a chat moderator 
  
Chat provides a convenient way for attendees to ask questions during a large meeting. To ensure that attendees receive 
timely answers to their questions, and to avoid interrupting the meeting, you can designate another attendee as a chat 
moderator. The moderator can answer attendees' questions in chat messages. At the beginning of the meeting, instruct 
attendees to use chat to ask questions and to direct their questions to the chat moderator.  
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Handling disruptive attendees 
  
To prevent a disruptive attendee from taking control away from the presenter, be careful when granting privileges to 
attendees. If an attendee continues to disrupt a meeting, you can expel the attendee by selecting the attendee’s name on 
the Participants panel, and then choosing Expel on the Participant menu. Once you expel an attendee, you can prevent 
the attendee from attempting to rejoin the meeting by choosing Restrict Access on the Meeting menu.  
 
 
Solving common problems 
  
The following are tips for solving and avoiding some common problems that you may encounter when using your WebEx 
Meeting Center.  
 
 
Clearing your Web browser's cache 
  
Clearing your Web browser's cache can improve your browser’s performance, and thereby your meeting experience. To 
clear you browser's cache, follow the instructions provided in your browser’s online Help.  
 
 
Handling firewall problems  
 
Your Meeting Center Web site sends and receives all meeting data through port 80—your firewall's standard HTTP port. 
You need not open any other ports on your firewall. If port 80 is open on your firewall but you still cannot use your WebEx 
Meeting Center Web site, please contact technical support.  
 
 
Leaving a meeting 
 
You can leave a meeting at any time. Meeting Manager disconnects you from the conference automatically once you leave 
the meeting. 

 To leave a meeting: 
o In the Meeting window, on the File menu, choose Leave Meeting. 
o A confirmation message appears, in which you can verify that you want to leave the meeting. 
o Click Yes. 
o The Meeting window closes. 

 
 
Contact Us 
 
If you would like technical assistance with Net Conferencing, please contact us at 
https://www.mymeetings.com/custom/res/content/resNumbers.php.  Our e-mail address is nettech@verizon.com. 
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